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ABSTRACT

Property databases are widely used for the design and analysis of refrigeration systems. Version 7 of the NIST
REFPROP (Reference Fluid Thermodynamic and Transport Properties) database is described. Compared with
previous versions, the database includes additional fluids and mixtures (including ammonia/water mixtures),
improved property models, additional properties, increased calculational speed, an enhanced user interface, and
support for using the property routines with other applications. This program is based on the most accurate equations
of state and transport property models currently available for pure fluids and fluid mixtures, and these sources are
internally documented in the database. The models are implemented in a suite of subroutines written in standard
Fortran, which may be used independently of the user interface. This database has become the de facto standard for
the properties of refrigerants.

INTRODUCTION

Knowledge of the thermophysical properties is essential for the evaluation of refrigerants and the design of
equipment using them. The REFPROP computer database from the National Institute of Standards and Technology
(NIST) has become one of the more widely used tools that provides these data. The initial versions of REFPROP
provided (sometimes preliminary) data to allow screening studies of possible replacements for the CFC and HCFC
refrigerants. As more and better data on the “new” refrigerants have become available, we have continually updated
the program to implement the most accurate pure fluid and mixture models available. Highly accurate properties on
the most common refrigerants are required to optimize the design of commercial equipment. But with the increasing
interest in hydrocarbons, carbon dioxide, and other non-fluorocarbon refrigerants, the need to evaluate and compare
many different fluids remains. In this paper, we describe version 7 of the REFPROP database (Lemmon et al. 2002).

REFPROP calculates a wide range of thermodynamic and transport properties; these are listed in Table 1. The
available fluids are given in Table 2. Mixtures with up to 20 components may be specified from among the 39 pure
fluids. Virtually any combination is allowed. The significant exception is that water and ammonia may be mixed
only with each other. The models used in REFPROP are described in this paper, and references to each type of
model are given. Whenever possible, we implement models published in peer-reviewed sources, and these sources
are internally documented in the database.

1.  THERMODYNAMIC MODELS

REFPROP calculates thermodynamic properties using comprehensive equations of state. This approach ensures
thermodynamic consistency and allows calculations at all conditions. Other approaches, such as the combination of
vapor-phase models with vapor pressure and liquid density equations, may not be applicable in the compressed
liquid and supercritical regions and do not always give reliable results for derived properties such as heat capacity.

1.1 Pure-Fluid Models
Four models are used for the thermodynamic properties of pure components. Most of the equations (and all of the
more recent formulations) are written in terms of the reduced molar Helmholtz free energy as a function of
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Table 1.  Properties computed with the REFPROP database

Thermodynamic properties
T temperature Cp heat capacity, const. p A Helmholtz free energy
ρ density w speed of sound G Gibbs free energy
p pressure, incl. vapor pressure Z compressibility factor ∆hV heat of vaporization
h enthalpy µJ Joule-Thompson coeff. f fugacity
e internal energy q vapor quality φ fugacity coefficient
s entropy B 2nd virial coefficient K K value
Cv heat capacity, const. ρ C 3rd virial coefficient V specific volume

Critical parameters
Tcrit critical temperature pcrit critical pressure ρcrit critical density

Transport properties
η viscosity λ thermal conductivity

Other properties
σ surface tension M molar mass κ isothermal compressibility
β volume expansivity k isentropic coefficient βs adiabatic compressibility
Ξ exergy ν kinematic viscosity α thermal diffusivity
Pr Prandtl number θ specific heat input

Derivatives
p/ ρ 2p/ ρ2 p/ T ρ/ T ρ/ p

temperature and density. The equation is composed of separate terms arising from ideal-gas behavior (superscript id)
and a “residual” or “real-fluid” (superscript r) contribution:

φ =
A

RT
= φid + φ r  , (1)

where R is the gas constant. The “residual” or “real-fluid” contribution is given by

φ r = Nkτtk δd k exp −α k δ − εk( ) lk[ ]
k

∑ exp −βk τ − γ k( )mk[ ] , (2)

where the temperature and density are expressed in the dimensionless variables τ = T*/T and δ = ρ/ρ*, where T*
and ρ* are reducing parameters that are often equal to the critical parameters. The Nk are numerical coefficients
fitted to experimental data. The multipliers αk and βk and exponents tk , dk , lk , and mk are optimized for a particular
fluid or group of fluids. The ideal-gas contribution is represented in terms of the heat capacity of the ideal-gas state.
The Helmholtz energy equation of state is described in detail by Lemmon and Jacobsen (2001); this paper also
describes the calculation of all the thermodynamic properties from the Helmholtz energy.

The parameters ε and γ appearing in eq. (2) are a relatively new extension of the traditional Helmholtz equation of
state form and are present for only a few fluids, including R125, carbon dioxide, nitrogen, and water. Lemmon and
Jacobsen (2003a) describe the techniques used in developing the R125 equation. These new terms improve the fit of
caloric properties in the critical region. New nonlinear fitting techniques allow extrapolation beyond the range of the
data, and provide a more physically reasonable behavior of the equation inside the vapor dome (two-phase region).
The equations for carbon dioxide and water contain additional terms to provide a more accurate representation of the
properties very close to the critical point (Span and Wagner, 1996).

The modified Benedict-Webb-Rubin (MBWR) equation of state is an older high-accuracy equation of state. See
Younglove and McLinden (1994) for a discussion of this equation. The Bender equation of state is used for R14,
R114, and RC318. This equation has been transformed into the equivalent Helmholtz energy form.

The fourth pure-fluid model is the extended corresponding states (ECS) model of Huber and Ely (1994). It is used
for fluids with limited data. Simple corresponding states is based on the assumption that, with the appropriate
scaling of temperature and density, the reduced residual Helmholtz energies and compressibilities (Z = p/RTρ) of an
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unknown fluid and a reference fluid (for which an accurate equation of state is available) are equal. When combined
with the ideal gas heat capacity, all other thermodynamic properties can be calculated. Simple corresponding states
was developed for spherically symmetric molecules. The ECS model extends the method to other types of molecules
by the introduction of the “shape factors” θ and φ. These shape factors are fitted to experimental data.

The MBWR, Bender, and ECS models are being replaced as new data are developed. For fluids with limited data, a
generalized “short form” Helmholtz energy equation is now preferred; it is described by Lemmon and Span (2003).

Table 2.  Fluids in the REFPROP database and models employed.

“R” number Chemical name Equation of state λ model η model

Halocarbons
R11 trichlorofluoromethane Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R12 dichlorodifluoromethane Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R13 chlorotrifluoromethane MBWR ECS, Ψ(T) ECS, Ψ(T)
R14 tetrafluoromethane Bender ECS, Ψ(T) ECS, Ψ(T)
R22 chlorodifluoromethane Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R23 trifluoromethane Helmholtz fluid-specific fluid-specific
R32 difluoromethane Helmholtz fluid specific ECS, Ψ(T)
R41 fluoromethane MBWR ECS, Ψ = 1 ECS, Ψ = 1
R113 1,1,2–trichloro–1,2,2–trifluoroethane Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R114 1,2–dichloro–1,1,2,2–tetrafluoroethane Bender ECS, Ψ(T) ECS, Ψ(T)
R115 chloropentafluoroethane ECS ECS, Ψ(T) ECS, Ψ(T)
R116 hexafluoroethane short Helmholtz ECS, Ψ = 1 ECS, Ψ = 1
R123 1,1–dichloro–2,2,2–trifluoroethane MBWR fluid-specific fluid-specific
R124 1–chloro–1,2,2,2–tetrafluoroethane Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R125 pentafluoroethane Helmholtz fluid specific ECS, Ψ(T)
R134a 1,1,1,2–tetrafluoroethane Helmholtz fluid-specific fluid-specific
R141b 1,1–dichloro–1–fluoroethane short Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R142b 1–chloro–1,1–difluoroethane short Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R143a 1,1,1–trifluoroethane Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R152a 1,1-difluoroethane MBWR fluid-specific ECS, Ψ(T)
R218 octafluoropropane short Helmholtz ECS, Ψ = 1 ECS, Ψ = 1
RC318 octafluorocyclobutane Bender ECS, Ψ(T) ECS, Ψ(T)
R227ea 1,1,1,2,3,3,3–heptafluoropropane short Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R236ea 1,1,1,2,3,3–hexafluoropropane ECS ECS, Ψ(T) ECS, Ψ(T)
R236fa 1,1,1,3,3,3–hexafluoropropane MBWR ECS, Ψ(T) ECS, Ψ(T)
R245ca 1,1,2,2,3–pentafluoropropane ECS ECS, Ψ(T) ECS, Ψ(T)
R245fa 1,1,1,3,3–pentafluoropropane ECS ECS, Ψ(T) ECS, Ψ(T)

Hydrocarbons
R50 methane Helmholtz fluid-specific fluid-specific
R170 ethane Helmholtz fluid-specific fluid-specific
R290 propane Helmholtz fluid-specific fluid-specific
R1270 propene (propylene) Helmholtz ECS, Ψ(T) ECS, Ψ(T)
R600 butane Helmholtz fluid-specific fluid-specific
R600a 2–methylpropane (isobutane) Helmholtz fluid-specific fluid-specific

Inorganics
R717 ammonia Helmholtz fluid-specific fluid-specific
R718 water Helmholtz fluid-specific fluid-specific
R728 nitrogen Helmholtz fluid-specific fluid-specific
R732 oxygen Helmholtz fluid-specific fluid-specific
R740 argon Helmholtz fluid-specific fluid-specific
R744 carbon dioxide Helmholtz fluid-specific fluid-specific

__________
“ECS, Ψ(T) ”  is the ECS method with the viscosity and thermal conductivity shape factors fitted to data
“ECS, Ψ = 1” is the ECS method in the predictive mode (Ψ = 1)
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1.2 Mixture Model
Thermodynamic properties of mixtures are calculated by applying mixing rules to the Helmholtz energy of the
mixture components together with a separate mixture function. The reduced Helmholtz energy of the mixture is:

φmix =
A

RT
= xi φi

id + ln x i[ ]
i =1

n

∑ + xiφi
r

i= 1

n

∑ + xi x jφ ij
excess

j =i + 1

n

∑
i = 1

n −1

∑ , with  φij
excess = Fij Nk

k

∑ δdk τ t k exp −δlk( ) . (3)

The first summation is the ideal gas contribution, where xi is the mole fraction of component i in the n component
mixture. The second summation represents the ideal solution; it consists of the residual terms for each of the pure
fluids. The double summation accounts for the “excess” Helmholtz energy or “departure” from the ideal solution.
The φi

r and φij
excess functions in eq. (3) are not evaluated at the temperature and density of the mixture Tmix and ρmix ,

but, rather, at a reduced temperature and density modified by “mixture parameters” ζij and ξij .

Generalized φij
excess functions have been developed for broad classes of mixtures by fitting to experimental data. The

Fij are parameters that scale the behavior of one binary pair with that of another. In REFPROP, one function is used
for the HFC mixtures, with additional terms required for the R32/125 and R32/134a pairs (Lemmon and Jacobsen,
2003b). The excess functions of Lemmon and Jacobsen (1999) and Lemmon et al. (2000) are used for hydrocarbon
blends and air, respectively. Ammonia/water mixtures use the model of Tillner-Roth and Friend (1998).

The Lemmon-Jacobsen model contains one generalized function φij
excess for each class of mixture and three mixture-

dependent parameters Fij, ζij, and ξij for each binary pair. Multicomponent mixtures are modeled using only the
constituent binary parameters. With this model, all of the thermodynamic properties can be calculated.

1.3 Predictive Model for Mixture Parameters
Ideally, Fij, ζij, and ξij would be determined from high-quality data for each binary pair of interest. However, for
cases where data are not available, a predictive model for the ζij parameter (Lemmon and McLinden, 2001) is used.
The ζij parameter is the most important of the parameters in the mixture model, and this single parameter captures
the most essential features of refrigerant mixture behavior, including the azeotropic behavior that exists for some
fluid pairs. A strictly empirical relation was developed using the critical temperature Tcrit, critical pressure pcrit, and
acentric factor ω  of each component. In this estimation scheme, ζij is given by

ζij
T1

crit

T2
crit = 40.4− 25.03× 2m ,  with  m =

T1
crit p2

critω2

T2
critp1

critω1

, (4)

where fluid “1” has the smaller value of the dipole moment. (When using only ζij, the parameters ξij and Fij in the
mixture model are set to zero.) Data for 76 binary pairs were used in the development of this method. The average
absolute deviation of the 4439 VLE data points analyzed was 1.77 %, based on ζij values fitted to experimental data,
compared to 4.50 % for ζij values calculated with eq. (4); the corresponding deviations for the 10373 p-ρ-T data
points were 0.94 % and 1.71 %. The deviations are smaller when fitted values of Fij, ζij, and ξij  are used.

2.  TRANSPORT PROPERTY MODELS

The transport properties of viscosity and thermal conductivity are modeled with the residual concept. In this model,
the property χ (representing either viscosity η or thermal conductivity λ) is composed of three contributions:

χ = χ id T( ) + ∆χ r T, ρ( ) + ∆χ crit T,ρ( )  . (5)

χid is a dilute-gas term that is a function only of temperature, and ∆χr is a residual term accounting for the behavior
at higher densities, including liquid densities. The thermal conductivity approaches infinity at the critical point, and
this critical enhancement is expressed by ∆χ crit. This term is significant for thermal conductivity even quite far from
the critical point. For viscosity, the enhancement is small except extremely close to the critical point. A variety of
fluid-specific correlations for viscosity and thermal conductivity have been taken from the literature and
implemented in the database, see, for example, Friend et al. (1991).

Where fluid-specific correlations are not available, the transport properties are modeled with the extended
corresponding states method of Klein et al. (1997) for viscosity and McLinden et al. (2000) for thermal
conductivity. The critical enhancement for thermal conductivity is the recent model by Huber et al. (2003); this
paper also provides details for the fitting of numerous fluids in the database. This method shares many of the
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concepts of the ECS model for the thermodynamic properties described above, but it employs a third shape factor Ψ,
which is a simple function of density. Separate Ψ functions for viscosity and thermal conductivity are fitted to data.
Where no data are available, the Ψ functions are set to 1; this is a “predictive mode.”

The ECS model is used to calculate the transport properties of all mixtures. There are no adjustable “mixture
parameters” for the transport properties, and this remains an area needing further research and model development.

The surface tension is available for all fluids in the database. The surface tension of mixtures is calculated using the
model of Moldover and Rainwater (1988). Where data are available, models are also provided for the freezing line
and sublimation line (although only the fluid properties, not solid properties, along these lines are calculated).

3.  PROPERTY SUBROUTINES

The property models described above are implemented as a suite of Fortran subroutines. Source code is provided
with the database so that users may compile and link the property routines with their own application. The routines
are written in ANSI-standard Fortran 90. They are written in a structured format, are internally documented with
extensive comments, and have been tested on a variety of compilers.

The available subroutines are summarized in Table 3. The entries in the table consist of the subroutine name and the
required input variables (see Table 1 for nomenclature). The fluid or mixture of interest is specified with a (required)
call to the subroutine “SETUP.” Iterative routines provide properties along the liquid-vapor saturation boundary.
“Flash” routines calculate single- or two-phase states given specified input quantities. These routines calculate, at a
minimum, the temperature, density, and composition of each phase present. For both the saturation and flash
routines, it is usually necessary to input these temperature, density, and composition values to a routine such as
THERM or TRNPRP to compute the other thermodynamic or transport properties that may be required.

Table 3.  Summary of property subroutines (required inputs shown in parentheses, see Table 1 for nomenclature)

Saturation routines
SATT (T, x or y)* SATP (p, x or y) SATD (ρ, x or y)
SATH (h, x or y) SATS (s, x or y)

Flash routines
TPFLSH (T, p, z)1,2 TDFLSH (T, ρ, z)2 TEFLSH (T, e, z)1,2

THFLSH (T, h, z)1,2 TSFLSH (T, s, z)1,2 PDFLSH (p, ρ, z)2

PEFLSH (p, e, z)1,2 PHFLSH (p, h, z)1,2 PSFLSH (p, s, z)1,2

DHFLSH (ρ, h, z)1 DSFLSH (ρ, s, z)1 DEFLSH (ρ, e, z)1

HSFLSH (h, s, z)1 TQFLSH (T, q, z)2 PQFLSH (p, q, z)2

Properties as f(T, ρ, z) Outputs Output(s)
TRNPRP (T, ρ, z) η,  λ SURFT (T, x) σ
THERM (T, ρ, z) p, e, h, s, Cv, Cp, w, µJ CRITP (z) Tcrit, pcrit, ρcrit

THERM2 (T, ρ, z) p, e, h, s, Cv, Cp, w, Z, µ J, A, G, κ, β, p/ρ, 2p/ ρ2, p/ T, ρ/ T, ρ/ p§

Virial coefficients Output Output
VIRB (T, y) B DBDT (T, y) B/ T
VIRC (T, y) C

Miscellaneous Output(s) Output(s)
FGCTY (T, ρ, z) f EXCESS (T, p, z) excess (V, e, h, s)
MELTT (T, x) p along melting line MELTP (p, x) T along melting line
SUBLT (T, y) p along sublimation line SUBLP (p, y) T along sublimation line

__________
*x and y are the compositions of the liquid and vapor phases, respectively; z is the overall, or “bulk” composition
1analogous routines for single-phase input states also available
2analogous routines for two-phase input states also available
§separate routines returning each of these properties singly are also available
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The routines mentioned above are independent of the model. Underlying these “high-level” routines are “core”
routines for each of the models implemented in the database. This structure is intended to simplify the addition of
future models to the database and will make such additions almost totally transparent to the user. Numerical
coefficients for the property models are stored in text files. There is one file per fluid and one file for all mixture
coefficients. These files are read upon the call to SETUP. Fluids can be added to the database without recompilation.

The Fortran routines are compiled into a dynamic link library (DLL) for use with the interface (described below).
This DLL also permits linking the REFPROP routines with Excel spreadsheets or a user’s application written in
Visual Basic. (Mention of commercial products is to fully specify the database and does not constitute endorsement
by NIST or imply that they are necessarily the best suited for the purpose.) Users have also linked the REFPROP
routines to MATLAB and LabVIEW applications, although these are not formally supported.

4.  USER INTERFACE

A graphical user interface has been developed for REFPROP 7 that is separate from the code implementing the
property models. The interface provides a convenient means to calculate and display properties. It is written for the
Windows operating system. The interface is written in Visual Basic, and it accesses the Fortran property subroutines
via the dynamic link library. A screen shot of the interface program is shown in Figure 1. The program is controlled
through the use of pull-down menus (visible at the top of Figure 1).

The File menu provides commands to save and print tables and plots. Individual items or entire sessions with
multiple windows may be saved or recalled. The copy and paste commands under the Edit menu allow data to be
exchanged with other applications. The Options menu provides commands for selecting the unit system, properties
of interest, and the reference state. A mass or molar basis for the composition and properties may be specified.
These options may be stored for recall at a later time. A user-defined set of preferences is loaded upon program
startup. The pure fluid or mixture of interest is specified with commands in the Substance menu. The refrigerant
mixtures having an ASHRAE R400 or R500-series designation are predefined. New mixtures can be specified and
saved. An information screen providing documentation for fluid constants, the source of the models, and their ranges
of applicability is available.

Figure 1: Screen shot of the REFPROP database
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The Calculate menu initiates the calculations that generate a property table. Each property selected for display is
shown in a separate column of the table. Two types of tables are provided. The first type, such as that shown in
Figure 1, provides properties at saturation or with a property (such as temperature or pressure) held constant with
another selected property varying over a specified range. The second type allows the user to select the independent
variables. Values of the independent variables may then be entered with the keyboard, read from a file, or pasted
from another application. The Plot menu allows graphing of any variables appearing in a table. In addition,
numerous thermodynamic diagrams may be generated automatically. Controls are provided to modify the plot size,
axis scaling, plot symbols, line type, legend, and other plot features.

Each table or plot appears in a separate window and can be accessed, resized, or retitled with commands in the
Window menu.  The number of windows is limited only by available memory. A complete online-help system can
be accessed through the Help menu.

The interface has the same overall structure as that in version 6 of the database, although it has been enhanced in
numerous ways. A new “spreadsheet-style” of entering data is available; this allows free-form data entry where, for
example, T and p could be the inputs on one line and T and h as inputs on another. Many of the calculations are
much faster. Many more thermodynamic diagrams are supported; 15 predefined diagrams are available and virtually
any other combination is possible. Many more properties are available (see Table 1), and more combinations of
input data are supported (see Table 3). More preferences are available to customize the behavior of the program.
Keyboard shortcuts are available for virtually all commands and for data entry in dialog boxes.

5.  DISCUSSION

5.1 Future Directions
The new, more general, title for REFPROP (Reference Fluid Thermodynamic and Transport Properties) with
“Reference Fluid” replacing the “Refrigerant” of earlier versions indicates our direction:  we will merge several
other NIST databases into REFPROP. The former AIRPROPS database for the properties of air has already been
included, and the NIST14 and NIST12 databases will follow during the next two years. Thus, a single database
would encompass refrigerants, cryogenic fluids, hydrocarbons, and simple inorganics. This approach will provide all
users a broader range of fluids and also make available improved algorithms and additional data types that will be
developed for other application areas. All current features, including the structure of the current property
subroutines, will be retained as new features are added, so that user applications written for REFPROP Version 7 are
also usable with future versions.

5.2 Relationship of REFPROP to International Standards
REFPROP implements current international property standards where they exist. A new ISO standard for the
properties of refrigerants is currently in the review process. This standard specifies values for the thermodynamic
properties of 10 refrigerants and four refrigerant blends, as calculated by published equations of state. The standard
does not specify any particular computer package, but the models specified in the draft ISO standard are the same
ones used in REFPROP. Thus, REFPROP will be compliant with the new standard, assuming its approval. If
different models are specified in future revisions of the standard, we will include those models in future updates.
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LA BASE DE DONNÉES REFPROP POUR LES PROPRIÉTÉS
THERMOPHYSIQUES DES FRIGORIGÈNES

RESUME:  Les bases de données sur les propriétés sont largement répandues pour la conception et l’analyse des
systèmes de réfrigération. Version 7 de la base de données REFPROP (Fluide de Référence Thermodynamique et
Propriétés de Transfert) de NIST est décrite. Par rapport aux versions précédents, la base de données contient les
fluides et les mélanges additionnels (mélanges y compris d’ammoniaque/l’eau), les modèles de propriété améliorés,
les propriétés additionnelles, la vitesse de calcul augmentée, l’interface utilisateur améliorée, et la capabilité
d’utiliser les routines de propriété en liaison d’autres applications. Ce programme est base sur les equations d’état
fluide pure et mélanges ainsi les modèles de propriété transfert les plus précises actuellement disponible, et ces
sources sont documentées dedans la base de données. Les modèles sont mis en application dans une suite des sous-
programmes écrits en Fortran standard qui peuvent être employées indépendamment de l’interface utilisateur. Cette
base de données est devenue le standard industriel pour les propriétés frigorigènes.


